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Safety warning notice

/\ WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor
Product Name HP Pavilion dvé Notebook PC J J
Processors AMD Athlon I N370 2.50-GHz processor (1.0-MB \/

L2 cache, 1066-MHz, 3.2GT/sec, dual core, 35 W)

AMD Athlon Il P360 2.30-GHz processor (1.0-MB \/
L2 cache, 1066-MHz, 3.2GT/sec, dual core, 25 W)

AMD Athlon Il P340 2.20-GHz processor (1.0-MB \/
L2 cache, 1066-MHz, 3.2GT/sec, dual core, 25 W)

AMD Phenom Il N970 2.20-GHz processor (2.0-MB \/
L2 cache, 1333-MHz, 3.6GT/sec, quad core, 35 W)

AMD Phenom I N870 2.30-GHz processor (1.5-MB \/
L2 cache, 1333-MHz, 3.6GT/sec, triple core, 35 W)

AMD Phenom Il N850 2.20-GHz processor (1.5-MB \/
L2 cache, 1333-MHz, 3.6GT/sec, triple core, 35 W)

AMD Phenom I N660 3.00-GHz processor (2.0-MB J
L2 cache, 1333-MHz, 3.6GT/sec, dual core, 35 W)

AMD Phenom Il P960 1.80-GHz processor (2.0-MB J
L2 cache, 1066-MHz, 3.6GT/sec, quad core, 25 W)

AMD Phenom Il P860 2.00-GHz processor (1.5-MB J
L2 cache, 1333-MHz, 3.6GT/sec, triple core, 25 W)

AMD Phenom Il P650 2.60-GHz processor (2.0-MB J
L2 cache, 1066-MHz, 3.6GT/sec, triple core, 25 W)

AMD Turion Il P570 2.70-GHz processor (2.0-MB J
L2 cache, 1066-MHz, 3.6GT/sec, dual core, 35 W)

AMD Turion Il P560 2.50-GHz processor (2.0-MB J
L2 cache, 1066-MHz, 3.6GT/sec, dual core, 25 W)

Intel Core i7-2820M 2.30-GHz (SC turbo up to 3.10- \/
GHz) processor (8.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2720M 2.20-GHz (SC turbo up to 3.00- \/
GHz) processor (6.0-MB L3 cache, quad core, 45 W)




Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor

Intel Core i7-2630M 2.00-GHz (SC turbo up to 2.90- y
GHz) processor (6.0-MB L3 cache, quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40- y
GHz) processor (4.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30- y
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20- y
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90- \/
GHz) processor (3.0-MB L3 cache, dual core, 35 W)

Intel Core i3-2310M 2.10-GHz processor (3.0-MB \/
L3 cache, dual core, 35 W)

Chipset Northbridge: AMD RS880MD y

Southbridge: AMD SB820M

Intel® HM65 Express chipset y

Graphics Internal graphics: ATi Mobility Radeon™ HD 4250 \/
graphics supporting DX10.1

Switchable discrete graphics:

e  ATi XT Radeon HD 6650M M2 package with
1024-MB of graphics subsystem discrete memory
(64-MB x 16 DDR3 @ 900MHz x 8 PCs), 128-
bit muxless

e ATi XT Radeon HD 6470M M2 package with
512-MB of graphics subsystem discrete memory
(64-MB x 16 DDR3 @ 900MHz x 4 PCs), 64-
bit muxless

Internal graphics: Intel HD Graphics 3000 v
Switchable discrete graphics:

e  ATIXT Radeon HD 6770M M2 package with
1024-MB of graphics subsystem discrete memory
(32-MB x 32 GDDR5 x 8 PCs, 5GBPS), muxless,
with reserve space for 2-GB graphics
subsystem memory

e ATi XT Radeon HD 6490M M2 package with
1024-MB of graphics subsystem discrete memory
(64-MB x 32 GDDR5 x 4 PCs, 5GBPS), with a
maximum of 1-GB of graphics subsystem
memory, muxless

Support DX11, HD decode, and HDMI \/ \/

Chapter 1 Product description



Category

Description

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Panel

15.6-in, high-definition (HD), light-emitting diode (LED),
low-voltage differential signalling (LVDS), SVA
BrightView (1366x768) display; typical brightness:
200 nits

All display assemblies include 2 wireless local area
network (WLAN) antenna cables

Supports 16:9 ultra wide aspect ratio

Lighted logo on top bezel

\/

\/

Memory

2 customer-accessible/upgradable memory
module slots

Supports dual-channel memory

Supports up to 8192 GB of system RAM

DDR3/1333-MHz

Supports the following configurations:
e 8192-MB total system memory (4096x2)

e  6144-MB total system memory (4096x1 +
2048x1)

e 4096-MB total system memory (4096x1 or
2048x2)

e 3072-MB total system memory (2048x1 +
1024x1)

e 2048-MB total system memory (2048x1 or
1024x2)

e 1024-MB total system memory (1024x1; not
supported on computer models equipped with an
AMD processor)

< | 2| < | <

< | 2| <2 | <

Hard drives

Supports 6.35-em (2.5-in) hard drives in 12.7-mm (.

50-in), 9.5-mm (.37-in), and 7.0-mm (.28-
in) thicknesses

Customer-accessible

Accelerometer / HDD protection support

Serial ATA




Category Description Computer models Computer models
equipped with an equipped with an

AMD processor Intel processor
Supporis the following configurations: \/ 3
e 17TB, 5400 rpm (12.7 mm)
e 750 GB, 7200 and 5400 rpm (9.5 mm)
e 640 GB, 7200 and 5400 rpm (9.5 mm)
e 500 GB, 7200 and 5400 rpm (9.5 mm)
e 320 GB, 7200 (7.0 mm) and 5400 rpm
(9.5 mm)
e 250 GB, 7200 rpm (7.0 mm)
Supports 160-GB solid-state drive y
Optical drive Fixed y y
Serial ATA N N
12.7-mm tray load y y
Blu-ray ROM with LightScribe DVD +R/RW Super Multi y y
Double-Layer Drive
Blu-ray Disc R/RW with SuperMulti Double-Layer Drive y
DVD+RW and CD-RW Super Multi Double-Layer \/ \/
Combo Drive with LightScribe
Supports zero-power optical drive 3
Audio and video  Dual array digital microphones with appropriate beam- y \/
forming, echo-cancellation, noise-suppression software
HD audio 3 3
HP-branded Altec/Lansing quad Beats Audio speakers y y
HP TrueVision HD webcam \/ y
Ethernet Integrated 10/100/1000 network interface v v
card (NIC)
Wireless Integrated wireless local area network (WLAN) options \/ \/
by way of wireless module
Two WLAN antennas built into display assembly y y

Chapter 1 Product description



Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor
Support for the following WLAN formats: J J
e  Broadcom 4313 802.11b/g/n 1x1 WiFi and
2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready)
®  Broadcom 4313 802.11b/g/n 1x1
WiFi Adapter
®  Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and
Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)
e  Ralink 5390GN 802.11b/g/n 1x1
WiFi Adapter
Support for the following WLAN formats: J
e Atheros 9285G 802.11b/g/n 1x1
WiFi Adapter
e Atheros ARBO02WB-1NGB 802.11b/g/n 1x1
WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)
®  Realtek RTL8191SE 802.11b/g/n 1x1
WiFi Adapter
®  Realtek 8188BC8 802.11a/b/g/n 2x2 WiFi
and Bluetooth 3.0+HS Combo Adapter
Support for the following WLAN formats: J
e Intel Centrino Advanced-N 6230
e Intel Centrino Wireless-N 1000
e Intel Centrino Wireless-N + WiMAX 6150
External media HP Multi-Format Digital Media Reader supports the J \/

card

following digital card formats:
e Secure Digital (SD) Memory Card

e Secure Digital Extended Capacity (SDxC)
Memory Card

e  Secure Digital High Capacity (SDHC)
Memory Card

e  Ultra High Speed MultiMediaCard (UHS/MMC)




Category Description Computer models Computer models
equipped with an equipped with an

AMD processor Intel processor
Ports e 3-pin AC power y y
e Audio-in (mono microphone)
e Audio-out (stereo headphone)
e HDMI version 1.4 supporting up to 1920 x1200
@ 60Hz
e  RJ-45 (Ethernet, includes link and activity lights)
e USB 2.0 (3 ports)
e  VGA (Dsub 15 pin) supporting 2048x1536
external resolution @ 75 Hz, hot plug and unplug
and auto-detection for correct output to wide-
aspect vs. standard aspect video
Keyboard/ Fullsize, textured, pocket, keyboard with \/ \/
pointing devices  numeric keypad
TouchPad with multitouch gestures, 2-finger scrolling, \/ \/
and pinch-zoom enabled
Dura-coat, island-style keyboard V y
Multitouch gestures (2-finger scrolling and pinch-zoom) \/ 3
enabled by default
Taps enabled by default y y
Power Support for the following 3-wire plug with \/ \/
requirements ground pin AC adapters (supports 3-pin
DC connector):
e 120W AC adapter with localized cable
plug support
e  90W EM AC adapter with localized cable
plug support
e 90W AC adapter with localized cable
plug support
e 65W EM AC adapter with localized cable
plug support
e 65W AC adapter with localized cable
plug support
Support for the following batteries: \/ \/
e 9cell, 100-Whr, 3.00-Ah Li-ion battery
e 6cell, 62-Whr, 2.80-Ah Li-ion battery
e 6cell, 55-Whr, 2.55-Ah Li-ion battery
Security Security cable slot y y
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Category Description Computer models Computer models
equipped with an equipped with an
AMD processor Intel processor
Fingerprint reader with Digital Persona J
software support
Supports Intel AT-p Ready J
Operating Preinstalled: 3
system
®  Windows 7 Home Basic
e Windows 7 Home Premium 64-bit
®  Windows 7 Professional 64-bit
Preinstalled: v
e Windows 7 Home Basic (64- and 32-bit)
e Windows 7 Home Premium (64- and 32-bit)
e  Windows 7 Professional (64- and 32-bit)
e Windows 7 Starter (32-bit)
e Windows 7 Ultimate (64-bit)
e FreeDOS
e  RedFlag
Serviceability End-user replaceable parts: \/ 3

e AC adapter

e  Battery

e  Hard drive

e Memory modules (2)
e Optical drive

e WILAN module
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2 External component identification

Display

1l

(—=T—T—

Item Component Description

(1) WILAN antennas (2)* Send and receive wireless signals to communicate
with WLANSs.

(2) Internal microphones (2) Record sound.

(3) Webcam light On: The webcam is in use.

(4) Webcam Records video and captures still photographs.

To use the webcam, select Start > All Programs >
Cyberlink YouCam > Cyberlink YouCam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Chapter 2 External component identification



Buttons, speakers, and fingerprint reader (select

models only)

Item

Component

Description

m

Power button

®  When the computer is off, press the button to turn on
the computer.

e When the computer is on, press the button briefly to
initiate Sleep.

®  When the computer is in the Sleep state, press the
button briefly to exit Sleep.

®  When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off

the computer.

To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options, or refer to the HP Notebook Reference Guide.

(2)

Speakers (2)

Produce sound.

(3)

Web browser button

Opens the default Web browser.

(4)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

Buttons, speakers, and fingerprint reader (select models only)
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Item Component

Description

(1) esc key

Displays system information when pressed in combination
with the fn key.

(2) fn key

Executes frequently used system functions when pressed
in combination with the num |k key, the b key, or the
esc key.

(3) Windows logo key

Displays the Windows Start menu.

(4) b key

Increases or decreases the Beats Audio bass settings
(select models only). Beats Audio is an enhanced audio
profile that provides a deep, controlled bass while
maintaining a clear sound. Beats Audio is enabled

by default.

You can also view and control the bass settings through
the Windows operating system. To view and control the
bass properties:

e  Select Start > All Programs > Beats Audio
Control Panel > Listening Experience.

—or—

o  Select Start > Control Panel > Hardware
and Sound > Beats Audio Control Panel >
Listening Experience.

(5) Windows applications key

Displays a shortcut menu for items beneath the pointer.

Chapter 2 External component identification



Item Component Description

(6) Integrated numeric keypad When the keypad has been enabled, the keys can be
used like an external numeric keypad.

(7) num lk key Enables/disables the integrated numeric keypad when
pressed in combination with the fn key.

(8) Action keys Execute frequently used system functions.

Lights

Item Component Description
(1) Caps lock light On: Caps lock is on.
(2) Power light e White: the computer is on.

e Blinking white: the computer is in the Sleep state.

e Off: the computer is off or in Hibernation.

(3) Mute light e Amber: Computer sound is off.

e Off: Computer sound is on.

lights 11



Item Component

Description

(4) Wireless light ®  White: An integrated wireless device, such as a
WILAN device and/or a Bluetooth device, is on.
e Amber: All wireless devices are off.
(5) Fingerprint reader light (select models only) @  White: The fingerprint was read.

e Amber: The fingerprint was not read.

TouchPad

12

M
I
o_

T4

Item Component Description
(1) TouchPad off light e On: The TouchPad is off.
e Off: The TouchPad is on.
(2) TouchPad on/off button Turns the TouchPad on and off.
(3) TouchPad zone Moves the pointer and selects or activates items on
the screen.
(4) Left TouchPad button Functions like the left button on an external mouse.
(5) TouchPad on light e On: The TouchPad is on.
e Off: The TouchPad is off.
(6) Right TouchPad button Functions like the right button on an external mouse.

Chapter 2 External component identification



Front

Item Component Description

(1) Digital Media Slot Supports the following digital card formats:
e  Secure Digital (SD) Memory Card

e Secure Digital Extended Capacity (SDxC)
Memory Card

e Secure Digital High Capacity (SDHC) Memory Card

e  Ultra High Speed MultiMediaCard (UHS/MMC)

(2) Speakers (2) (select models only) Produce sound.

Component Description

Vent Enables airflow to cool internal components.

NOTE: the computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal
for the internal fan to cycle on and off during

routine operation.

Front

13



Left side

14
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Item Component

Description

(1) Vent

Enables airflow to cool internal components.

NOTE: the computer fan starts up automatically to cool
infernal components and prevent overheating. It is normal
for the internal fan to cycle on and off during

routine operation.

(2) External monitor port

Connects an external VGA monitor or projector.

(3) HDMI port

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

4) R)-45 (network) jack

Connects a network cable.

(5) SuperSpeed USB ports (2)

Connect optional USB 3.0 devices (select models only)
and provide enhanced USB power performance.

NOTE: The SuperSpeed USB ports are also compatible
with USB 1.0 and USB 2.0 devices.

(6) Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7) Audio-out (headphone) jacks (2)

Produce sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and

Environmental Notices.

NOTE: When a device is connected to a headphone
jack, the computer speakers are disabled.

Chapter 2 External component identification



Right side
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OeE®®

Item Component Description

(1) Optical drive Reads and writes (select models only) to an optical disc.

(2) Optical drive light e  Green: The optical drive is being accessed.

e Off: The optical drive is off.

(3) Optical drive eject button Ejects the optical drive.

(4) Power light e White: the computer is on.

e Blinking white: the computer is in the Sleep state.
e Off: the computer is off or in Hibernation.

(5) Drive light e  Blinking white: The hard drive is being accessed.

e Amber: HP ProtectSmart Hard Drive Protection has
temporarily parked the hard drive.
NOTE: For information on HP ProtectSmart Hard
Drive Protection, refer to the HP Notebook
Reference Guide.

(6) USB ports (2) Connect optional USB devices.

(7) Security cable slot Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deferrent, but it may not prevent the computer from being
mishandled or stolen.

(8) Battery light e White: the computer is connected to external power

and the battery is fully charged.

e Amber: A battery is charging.

e Blinking amber: The battery has reached a low
battery level, or there is a battery error. When a
battery reaches a critical battery level, the battery
light begins blinking rapidly.

(9) Power connector Connects an AC adapter.

Right side
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Bottom

16

Item Component Description

(1) Battery bay Holds the battery.

(2) Battery release latch Releases the battery from the battery bay.

(3) Vents (6) Enable airflow to cool internal components.
NOTE: the computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

(4) Hard drive bay Contains the hard drive, the WLAN device, and the

memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

Chapter 2 External component identification



3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model number

provided on the service tag.

(O XXO0OOX
©— Serial: X000000CK I NN NMAMAINNY

—Produd: X2O0000C [IINNMEMNINNNNIN
—"-"M'-’gﬁmr 1y1yOy

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

Service tag

17
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Item Component Description

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate

documents, drivers, and support for the computer.

Chapter 3 lllustrated parts catalog



Computer major components

Item Component Spare part number

() 15.6-in, high definition (HD), light-emitting diode (LED), BrightView display assembly (includes
webcam, two microphones, and wireless antenna transceivers and cables)

In butter gold finish 641482001

Computer major components 19



ltem Component Spare part number

In dark umber finish 640431001
In espresso black finish 640430001
In linen white finish 640433-001
In Pacific blue finish 641479001
In pearl pink finish 641481001
In ruby red finish 640434001
In Sonoma red finish 641480-001
In steel gray finish 650798-001

NOTE: For more display assembly spare part information, see Display assembly subcomponents on page 28.

(2) Keyboard (includes keyboard cable):

Keyboard in black finish:

For use only with computer models equipped with an AMD processor in Brazil 640436-201
For use only with computer models equipped with an Intel processor in Israel 640436-BB1
For use only with computer models equipped with an Intel processor in Japan 640436-291
For use only with computer models equipped with an Intel processor in South Korea 640436-AD1
For use only with computer models equipped with an Intel processor in Taiwan 640436-AB1
For use only with computer models equipped with an Intel processor in Thailand 640436-281

For use with all computer models:

For use in Belgium 640436-A41
For use in Canada 640436-121
For use in the Czech Republic and Slovakia 640436221
For use in Denmark, Finland, and Norway 640436-DH1
For use in France 640436-051
For use in Germany 640436-041
For use in Greece 640436-D)1
For use in Hungary 640436-211
For use in ltaly 640436-061
For use in Latin America 640436-161
For use in the Netherlands 640436-B31
For use in Portugal 640436-131
For use in Russia 640436-251
For use in Saudi Arabia 640436-171
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For use in Slovenia 640436-BA1
For use in Spain 640436-071
For use in Switzerland 640436-BG1
For use in Turkey 640436-141
For use in the United Kingdom 640436031
For use in the United States 640436001
Keyboard in silver finish:

For use only with computer models equipped with an AMD processor in Brazil 644363-201
For use only with computer models equipped with an Intel processor in Israel 644363-BB1
For use only with computer models equipped with an Intel processor in Japan 644363291
For use only with computer models equipped with an Intel processor in South Korea 644363-AD1
For use only with computer models equipped with an Intel processor in Taiwan 644363-AB1
For use only with computer models equipped with an Intel processor in Thailand 644363-281
For use with all computer models:

For use in Belgium 644363-A41
For use in Canada 644363-121
For use in the Czech Republic and Slovakia 644363221
For use in Denmark, Finland, and Norway 644363-DH1
For use in France 644363-051
For use in Germany 644363-041
For use in Greece 644363-DJ1
For use in Hungary 644363-211
For use in Italy 644363-061
For use in Latin America 644363-161
For use in the Netherlands 644363831
For use in Portugal 644363-131
For use in Russia 644363-251
For use in Saudi Arabia 644363-171
For use in Slovenia 644363-BA1
For use in Spain 644363-071
For use in Switzerland 644363-BG1
For use in Turkey 644363-141
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For use in the United Kingdom 644363-031
For use in the United States 644363-001
(3) Top cover (includes TouchPad and TouchPad button board, but does not include TouchPad cable or TouchPad

button board cable):

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit, spare part number

640422-001.
In butter gold finish 641497001
In dark umber finish 640463-001
In espresso black finish 640458001
In linen white finish 640460-001
In Pacific blue finish 641494001
In pearl pink finish 641496001
In ruby red finish 640461001
In Sonoma red finish 641495-001
In steel gray finish 650802001
(4) Power button board (does not include cable) 640439-001

NOTE: The power button board cable is not included in the power button board
spare part kit. The power button board cable is included in the Cable Kit, spare part
number 640422-001.

(5) Fingerprint reader board (select models only, includes bracket, but does not 640427-001
include cable)

NOTE: The fingerprint reader board cable is not included in the fingerprint reader
board spare part kit. The fingerprint reader board cable is included in the Cable Kit,
spare part number 640422-001.

(6) Bluetooth module (for use only with computer models equipped with an 537921-001
Intel processor)

NOTE: The Bluetooth module spare part kit does not include the Bluetooth
module cable. The Bluetooth module cable is available in the Cable Kit, spare part

number 641478-001.

(7) Bluetooth module cable (for use only with computer models equipped with an 641478001
Intel processor)

(8) USB board (does not include cable) 640441-001

NOTE: The USB board cable is not included in the USB board spare part kit. The
USB board cable is included in the Cable Kit, spare part number 640422-001.

Cable Kit, includes: 640422-001
(9a) Optical drive connector cable
(9b) Hard drive connector cable
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Component

Spare part number

Not illustrated:

Power button board cable

Fingerprint reader board cable

TouchPad cable

TouchPad button board cable

USB board cable

NOTE: See Cable Kit on page 27 for more Cable Kit spare part information.

(10)

Power connector cable

640424-001

am

Speaker cover:

For use only with computer models in dark umber and steel gray finish

641438-001

For use only with computer models in butter gold, espresso black, linen white, Pacific

blue, pearl pink, ruby red, and Sonoma red finish

640443-001

(12)

Speaker Kit (includes left and right speakers and cable)

640449-001

(13)

System board (includes replacement thermal material):

For use only with computer models equipped with an AMD processor:

Equipped with the RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB

of graphics subsystem discrete memory, and USB version 3.0

640454-001

Equipped with the RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB

of graphics subsystem discrete memory, and USB version 2.0

640452-001

Equipped with the RS880MD chipset, HD6470 graphics subsystem chipset, 512-MB of

graphics subsystem discrete memory, and USB version 3.0

640453-001

Equipped with the RS880MD chipset, HD6470 graphics subsystem chipset, 512-MB of

graphics subsystem discrete memory, and USB version 2.0

640451-001

Equipped with the RS880M chipset, a graphics subsystem with UMA memory, and
USB version 3.0

640455-001

Equipped with the RS880M chipset, a graphics subsystem with UMA memory, and
USB version 2.0

640450-001

For use only with computer models equipped with an Intel processor:

For use only with computer models equipped with a quad core processor, the Intel
HD6770 graphics subsystem, and 2048-MB of discrete memory

650799-001

For use only with computer models equipped with a dual core processor, the Intel
HD6770 graphics subsystem, and 2048-MB of discrete memory

650800-001

For use only with computer models equipped with a quad core processor, the Intel
HD6770 graphics subsystem, and 1024-MB of discrete memory

641488-001

For use only with computer models equipped with a dual core processor, the Intel

HD6770 graphics subsystem, and 1024-MB of discrete memory

641489-001
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ltem Component Spare part number
For use only with computer models equipped with a quad core processor, the Intel 641486-001
HD6490 graphics subsystem, and 1024-MB of discrete memory
For use only with computer models equipped with a dual core processor, the Intel 641484001
HD6490 graphics subsystem, 1024-MB of discrete memory, and USB version 3.0
For use only with computer models equipped with a dual core processor, the Intel 641487001
HD6490 graphics subsystem, 1024-MB of discrete memory, and USB version 2.0
For use only with computer models equipped with a quad core processor, a graphics ~ 641491-001
subsystem with UMA memory, and USB version 3.0
For use only with computer models equipped with a dual core processor, a graphics 641485-001
subsystem with UMA memory, and USB version 3.0
For use only with computer models equipped with a dual core processor, a graphics 641490-001
subsystem with UMA memory, and USB version 2.0
Thermal Material Kit (not illustrated, includes replacement thermal paste and pads)
For use only with computer models equipped with an AMD processor and a graphics ~ 640457-001
subsystem with discrete memory
For use only with computer models equipped with an AMD processor and a graphics ~ 640456-001
subsystem with UMA memory
For use only with computer models equipped with an Intel processor and a graphics 650801-001
subsystem with 2048-MB of discrete memory
For use only with computer models equipped with an Intel processor and a graphics 641493001
subsystem with 1024-MB of discrete memory
For use only with computer models equipped with an Intel processor and a graphics 641492-001
subsystem with UMA memory

(14) Processor (includes replacement thermal material)
AMD Athlon I N370 2.50-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, 634686-001
dual core, 35 W)
AMD Athlon Il P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec,  636635-001
dual core, 25 W)
AMD Athlon Il P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, 616343-001
dual core, 25 W)
AMD Phenom I N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/ 635496-001
sec, quad core, 35 W)
AMD Phenom Il N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/ 635495-001
sec, triple core, 35 W)
AMD Phenom Il N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/ 616345-001
sec, triple core, 35 W)
AMD Phenom Il N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/ 635494-001
sec, dual core, 35 W)
AMD Phenom Il P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, 634689-001

quad core, 25 W)
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AMD Phenom Il P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, 634688-001
triple core, 25 W)

AMD Phenom Il P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, 634687-001
triple core, 25 W)

AMD Turion Il P570 2.70-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,  634690-001
dual core, 35 W)

AMD Turion Il P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, 634691-001
dual core, 25 W)

Intel Core i7-2820M 2.30-GHz (SC turbo up to 3.10-GHz) processor (8.0-MB 634694-001
L3 cache, quad core, 45 W)

Intel Core i7-2720M 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB 631254-001
L3 cache, quad core, 45 W)

Intel Core i7-2630M 2.00-GHz (SC turbo up to 2.90-GHz) processor (6.0-MB 635501-001
L3 cache, quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB 631252-001
L3 cache, dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB 631255-001
L3 cache, dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB 631253-001
L3 cache, dual core, 35 W)

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB 638039-001
L3 cache, dual core, 35 W)

Intel Core i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W) 638037-001

(15) Fan/heat sink assembly (includes replacement thermal material):

For use only with computer models equipped with an AMD processor:

For use only with computer models equipped with a graphics subsystem with 640426-001
discrete memory

For use only with computer models equipped with a graphics subsystem with 640425-001
UMA memory

For use only with computer models equipped with an Intel processor:

For use only with computer models equipped with a graphics subsystem with 2048-MB  650797-001
discrete memory

For use only with computer models equipped with a graphics subsystem with 1024-MB  641477-001
discrete memory

For use only with computer models equipped with a graphics subsystem with 641476001
UMA memory

(16) Base enclosure (includes battery release latch and 4 rubber feet)

For use only with computer models in dark umber and steel gray finish 640419-001
For use only with computer models in butter gold, espresso black, linen white, Pacific ~ 640418-001

blue, pearl pink, ruby red, and Sonoma red finish
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(17) Battery:
9-cell, 100-Whr, 3.00-Ah Li-ion battery 636631-001
6-cell, 62-Whr, 2.80-Ah Li-ion battery 593562-001
6-cell, 55-Whr, 2.55-Ah Li-ion battery 593554-001

(18) Memory modules (2, DDR3, 10600, 1333-MHz):

4 GB 621569-001
2 GB 621565001
1 GB 639736001
(19) RTC battery 608771-001
(20) Hard drive (2.5-in, SATA, does not include hard drive bracket, hard drive connector cable, or screws):
1-TB, 5400-rpm, 12.7 mm 638974-001
750-GB, 7200-rpm, 9.5 mm 633252-001
750-GB, 5400-rpm, 9.5 mm 634250-001
640-GB, 7200-rpm, 9.5 mm 621046001
500-GB, 7200-rpm, 9.5 mm 608218-001
320-GB, 7200-rpm, 7.0 mm 641672001 and
634862001
250-GB, 7200-rpm, 7.0 mm 635225-001 and
634861-001
160-GB solid-state drive (not illustrated, for use only with computer models 641825-001

equipped with an Intel processor)

Hard Drive Hardware Kit (not illustrated, includes hard drive bracket and screws)  640428-001

(21) WLAN module:

For use on all computer models:

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo 600370-001
adapter (BT3.0+HS ready)

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001

Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter ~ 630705-001
(BT3.0+HS ready)

Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter 630703-001

For use only with computer models equipped with an AMD processor:

Atheros 9285G 802.11b/g/n 1x1 WiFi Adapter 605560-005

Atheros ARB002WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo ~ 593127-001
Adapter (BT3.0+HS ready)

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 640926-001
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Realtek 8188BC8 802.11a/b/g/n 2x2 WiFi and Bluetooth 3.0+HS Combo Adapter  602993-001

For use only with computer models equipped with an Intel processor:

Intel Centrino Advanced-N 6230 631956-001
Intel Centrino Wireless-N 1000 593530-001
Intel Centrino Wireless-N + WiMAX 6150 633817-001

(22) Optical drive (includes bezel and bracket):

Blu-ray ROM with LightScribe DVD +R/RW Super Multi Double-Layer Drive for use only  641824-001
with computer models equipped with an Intel processor

DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 641809-001

(23) Service cover — available in the Plastics Kit, spare part number 640444-001

Cable Kit
9—[3‘ —0
— o

\ . e~ o

Item Component Spare part number
Cable Kit, includes: 640422-001

(1) Optical drive connector cable

(2) Hard drive connector cable

(3) Fingerprint reader board cable

(4) USB board cable

(5) TouchPad cable

(6) TouchPad button board cable

(7) Power button board cable
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Display assembly subcomponents

Item Component Spare part number
(1) Display hinge covers (2) 641807-001
(2) Display bezel:
For use only with computer models in dark umber and steel gray finish 640421-001
For use only with computer models in butter gold, espresso black, linen white, Pacific ~ 640420-001
blue, pearl pink, ruby red, and Sonoma red finish
(3) Display Hinge Kit (includes left and right display hinges and brackets) 640429-001
(4) 15.6-in, HD, LED, BrightView display panel 640445-001
(5) Display Cable Kit (includes display panel cable and webcam/microphone module cable)
For use only with computer models in dark umber and steel gray finish 644362-001
For use only with computer models in butter gold, espresso black, linen white, Pacific ~ 640423-001
blue, pearl pink, ruby red, and Sonoma red finish
(6) Webcam/microphone module 639387-001
(7) Antenna Kit (includes left and right wireless antenna cables and transceivers) 640411-001
(8) Display enclosure:
In butter gold finish 641475001
In dark umber finish 640417-001
In espresso black finish 640412-001
In linen white finish 640414-001
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In Pacific blue finish 641472-001
In pearl pink finish 641474001
In ruby red finish 640415-001
In Sonoma red finish 641473-001
In steel gray finish 650796001
Display Rubber Kit (not illustrated) 641810-001
Display Screw Kit (not illustrated) 640448-001
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Mass storage devices

07

Item Component Spare part number
(1) Hard drive (2.5-in, SATA, does not include hard drive bracket, hard drive connector cable, or screws):
1-TB, 5400-rpm, 12.7 mm 638974-001
750-GB, 7200-rpm, 9.5 mm 633252-001
750-GB, 5400-rpm, 9.5 mm 634250-001
640-GB, 7200-rpm, 9.5 mm 621046-001
500-GB, 7200-rpm, 9.5 mm 608218-001
320-GB, 7200-rpm, 7.0 mm 641672-001 and
634862-001
250-GB, 7200-rpm, 7.0 mm 635225-001 and
634861-001
Hard Drive Hardware Kit, includes: 640428-001
(2) Hard drive bracket
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Hard drive screws (not illustrated)

(3) 160-GB solid-state drive (for use only with computer models equipped with an 641825001
Intel processor)

(4) Optical drive (includes bezel and bracket):

Blu-ray ROM with LightScribe DVD +R/RW Super Multi Double-Layer Drive for use only  641824-001
with computer models equipped with an Intel processor

DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 641809-001

Miscellaneous parts

Component Spare part number

HP Smart AC adapter:

For use with all computer models:

120-W PFC RC V HP Smart AC adapter 609941-001
90-W PFC RC V HP Smart AC adapter 609940001
65-W RC V HP Smart AC adapter 609939-001

For use only with computer models equipped with an Intel processor:

90-W PFC RC V EM HP Smart AC adapter 609947-001

65-W RC V EM HP Smart AC adapter 609948-001

Power cord (3-pin, black, 1.83-m):

For use with all computer models:

For use in Argentina 490371-DO1
For use in Denmark 490371-081
For use in Europe 490371-021
For use in ltaly 490371061
For use in North America 490371-001
For use in South Africa 490371-AR1
For use in Switzerland 490371-111
For use in the United Kingdom and Singapore 490371-031
For use only with computer models equipped with AMD processors in Brazil 490371-202

For use only with computer models equipped with Intel processors:

For use in Australia 490371-111

For use in India 490371-D61
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For use in Israel 490371-BB1
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Korea 490371-AD1
For use in Taiwan 490371-AB1
For use in Thailand 490371-281
Remote control (fullfunction, with teletext) 465541-004
USB DVD-T antenna 581223-001
USB DVB-T TV tuner 581222-001
Screw Kit 640447001

Sequential part number listing
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Spare part number

Description

465541-004 Remote control (full-function, with teletext)

490371-001 Power cord for use with all computer models in North America (3-pin, black, 1.83-m)

490371011 Power cord for use only with computer models equipped with an Intel processor in Australia (3-
pin, black, 1.83-m)

490371-021 Power cord for use with all computer models in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use with all computer models in the United Kingdom and Singapore (3-pin, black,
1.83-m)

490371-061 Power cord for use with all computer models in ltaly (3-pin, black, 1.83-m)

490371-081 Power cord for use with all computer models in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use with all computer models in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use only with computer models equipped with an Intel processor in Thailand (3-
pin, black, 1.83-m)

490371-202 Power cord for use only with computer models equipped with an AMD processor in Brazil (3-pin,
black, 1.83-m)

490371-291 Power cord for use only with computer models equipped with an Intel processor in Japan (3-pin,
black, 1.83-m)

490371-AA1 Power cord for use only with computer models equipped with an Intel processor in the People's
Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use only with computer models equipped with an Intel processor in Taiwan (3-pin,
black, 1.83-m)

490371-AD1 Power cord for use only with computer models equipped with an Intel processor in South Korea

(3-pin, black, 1.83-m)
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Description

490371-AR1 Power cord for use with all computer models in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use only with computer models equipped with an Intel processor in Israel (3-pin,
black, 1.83-m)

490371-DO1 Power cord for use with all computer models in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use only with computer models equipped with an Intel processor in India (3-pin,
black, 1.83-m)

537921-001 Bluetooth module (for use only with computer models equipped with an Intel processor)
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 640206-001.

581222-001 USB DVB-T TV tuner

581223-001 USB DVD-T antenna

593127-001 Atheros AR8002WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

593530-001 Intel Centrino WirelesssN 1000 WLAN module for use only on computer models equipped with
an Intel processor

593554-001 6-cell, 55-Whr, 2.55-Ah Li-ion battery

593562-001 6-cell, 62-Whr, 2.80-Ah Li-ion battery

593836-001 Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use with all computer models

600370-001 Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use with all computer models

602993-001 Realtek 8188BC8 802.11a/b/g/n 2x2 WiFi and Bluetooth 3.0+HS Combo Adapter for use
only with computer models equipped with an AMD processor

605560-005 Atheros 9285G 802.11b/g/n 1x1 WiFi Adapter for use only with computer models equipped
with an AMD processor

608218-001 500-GB, 7200-rpm, 9.5 mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

608771-001 RTC battery (includes cable and double-sided tape)

609939001 65-W RC V HP Smart AC adapter for use with all computer models

609940001 90-W PFC RC V HP Smart AC adapter for use with all computer models

609941-001 120-W PFC RC V HP Smart AC adapter for use with all computer models

609947-001 90-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

609948001 65-W PFC RC V EM HP Smart AC adapter for use only with computer models equipped with an
Intel processor

616343-001 AMD Athlon Il P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W; includes replacement thermal material)

616345-001 AMD Phenom Il N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,

triple core, 35 W; includes replacement thermal material)
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Spare part number

Description

621046-001 640-GB, 7200-rpm, 9.5 mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

621565-001 2-GB memory module (DDR3, 10600, 1333-MHz)

621569-001 4-GB memory module (DDR3, 10600, 1333-MHz)

630703-001 Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter for use with all computer models

630705-001 Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready) for use with all computer models

631252001 Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4-MB L3 cache, dual core,
35 W; includes replacement thermal material)

631253-001 Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

631254-001 Intel Core i7-2720M 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB L3 cache,
quad core, 45 W; includes replacement thermal material)

631255-001 Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

631956-001 Intel Centrino Advanced-N 6230 WLAN module for use only on computer models equipped with
an Intel processor

633252001 750-GB, 7200-rpm, 9.5 mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

633817-001 Intel Centrino Wireless-N + WiMAX 6150 WLAN module for use only with computer models
equipped with an Intel processor

634250-001 750-GB, 5400-rpm, 9.5 mm hard drive for use with all computer models (2.5-in, SATA, does not
include hard drive bracket, hard drive connector cable, or screws)

634686-001 AMD Athlon I N370 2.50-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
35 W; includes replacement thermal material)

634687-001 AMD Phenom Il P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W; includes replacement thermal material)

634688-001 AMD Phenom Il P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 25 W; includes replacement thermal material)

634689-001 AMD Phenom Il P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
quad core, 25 W; includes replacement thermal material)

634690-001 AMD Turion Il P570 2.70-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core,
35 W; includes replacement thermal material)

634691-001 AMD Turion Il P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core,
25 W; includes replacement thermal material)

634861-001 250-GB, 7200-rpm, 7.0 mm hard drive (2.5-in, SATA, does not include hard drive bracket,
hard drive connector cable, or screws)

634862-001 320-GB, 7200-rpm, 7.0 mm hard drive (2.5-in, SATA, does not include hard drive bracket,
hard drive connector cable, or screws)

635225-001 250-GB, 7200-rpm, 7.0 mm hard drive (2.5-in, SATA, does not include hard drive bracket,

hard drive connector cable, or screws)
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Spare part number

Description

635494-001 AMD Phenom Il N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
dual core, 35 W; includes replacement thermal material)

635495-001 AMD Phenom Il N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W; includes replacement thermal material)

635496-001 AMD Phenom Il N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
quad core, 35 W; includes replacement thermal material)

635501-001 Intel Core i7-2630M 2.00-GHz (SC turbo up to 2.90-GHz) processor (6.0-MB L3 cache,
quad core, 45 W; includes replacement thermal material)

636631-001 9-cell, 100-Whr, 3.00-Ah Li-ion battery

636635-001 AMD Athlon Il P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W; includes replacement thermal material)

638037-001 Intel Core i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

638039-001 Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

638974-001 1-TB, 5400-rpm, 12.7 mm hard drive (2.5-in, SATA, does not include hard drive bracket,
hard drive connector cable, or screws)

639387-001 Webcam/microphone module

639736-001 1-GB memory module (DDR3, 10600, 1333-MHz)

640411-001 Antenna Kit (includes left and right wireless antenna cables and transceivers)

640412-001 Display enclosure in espresso black finish

640414-001 Display enclosure in linen white finish

640415-001 Display enclosure in ruby red finish

640417-001 Display enclosure in dark umber finish

640418-001 Base enclosure for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish (includes battery release latch and 4
rubber feet)

640419-001 Base enclosure for use only with computer models in dark umber and steel gray finish (includes
battery release latch and 4 rubber feet)

640420-001 Display bezel for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish

640421-001 Display bezel for use only with computer models in dark umber and steel gray finish

640422-001 Cable Kit (includes the optical drive connector cable, hard drive connector cable, power button
board cable, fingerprint reader board cable, TouchPad cable, TouchPad button board cable, and
USB board cable)
NOTE: See Cable Kit on page 27 for more Cable Kit spare part information.

640423001 Display Cable Kit for use only with computer models in butter gold, espresso black, linen white,

Pacific blue, pearl pink, ruby red, and Sonoma red finish (includes display panel cable and
webcam/microphone module cable)
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Spare part number

Description

640424-001 Power connector cable

640425-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and
a graphics subsystem with UMA memory (includes replacement thermal material)

640426-001 Fan/heat sink assembly for use only with computer models equipped with an AMD processor and
a graphics subsystem with discrete memory (includes replacement thermal material)

640427001 Fingerprint reader board (select models only, includes bracket, but does not include cable)
NOTE: The fingerprint reader board cable is not included in the fingerprint reader board spare
part kit. The fingerprint reader board cable is included in the Cable Kit, spare part number
640422-001.

640428-001 Hard Drive Hardware Kit (includes hard drive bracket and screws)

640429-001 Display Hinge Kit (includes left and right display hinges and brackets)

640430-001 15.6-in, HD, LED, BrightView display assembly in espresso black finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640431-001 15.6-in, HD, LED, BrightView display assembly in dark umber finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640433-001 15.6-in, HD, LED, BrightView display assembly in linen white finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640434001 15.6-in, HD, LED, BrightView display assembly in ruby red finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640436001 Keyboard in black finish for use with all computer models in the United States (includes
keyboard cable)

640436031 Keyboard in black finish for use with all computer models in the United Kingdom and Singapore
(includes keyboard cable)

640436041 Keyboard in black finish for use with all computer models in Germany (includes keyboard cable)

640436-051 Keyboard in black finish for use with all computer models in France (includes keyboard cable)

640436-061 Keyboard in black finish for use with all computer models in ltaly (includes keyboard cable)

640436071 Keyboard in black finish for use with all computer models in Spain (includes keyboard cable)

640436-121 Keyboard in black finish for use with all computer models in Canada (includes keyboard cable)

640436-131 Keyboard in black finish for use with all computer models in Portugal (includes keyboard cable)

640436-141 Keyboard in black finish for use with all computer models in Turkey (includes keyboard cable)

640436-161 Keyboard in black finish for use with all computer models in Latin America (includes
keyboard cable)

640436-171 Keyboard in black finish for use with all computer models in Saudi Arabia (includes
keyboard cable)

640436-201 Keyboard in black finish for use only with computer models equipped with an AMD processor
in Brazil (includes keyboard cable)

640436211 Keyboard in black finish for use with all computer models in Hungary (includes keyboard cable)
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Spare part number

Description

640436-221 Keyboard in black finish for use with all computer models in the Czech Republic and Slovakia
(includes keyboard cable)

640436-251 Keyboard in black finish for use with all computer models in Russia (includes keyboard cable)

640436-281 Keyboard in black finish for use only with computer models equipped with an Intel processor
in Thailand (includes keyboard cable)

640436-291 Keyboard in black finish for use only with computer models equipped with an Intel processor
in Japan (includes keyboard cable)

640436-A41 Keyboard in black finish for use with all computer models in Belgium (includes keyboard cable)

640436-AB1 Keyboard in black finish for use only with computer models equipped with an Intel processor
in Taiwan (includes keyboard cable)

640436-AD1 Keyboard in black finish for use only with computer models equipped with an Intel processor
in South Korea (includes keyboard cable)

640436831 Keyboard in black finish for use with all computer models in the Netherlands (includes
keyboard cable)

640436-BA1 Keyboard in black finish for use with all computer models in Slovenia (includes keyboard cable)

640436-BB1 Keyboard in black finish for use only with computer models equipped with an Intel processor
in Israel (includes keyboard cable)

640436-BG1 Keyboard in black finish for use with all computer models in Switzerland (includes
keyboard cable)

640436-DH1 Keyboard in black finish for use with all computer models in Denmark, Finland, and Norway
(includes keyboard cable)

640436-D)1 Keyboard in black finish for use with all computer models in Greece (includes keyboard cable)

640439-001 Power button board (does not include cable)
NOTE: The power button board cable is not included in the power button board spare part kit.
The power button board cable is included in the Cable Kit, spare part number 640422-001.

640441-001 USB board (does not include cable)
NOTE: The USB board cable is not included in the USB board spare part kit. The USB board
cable is included in the Cable Kit, spare part number 640422-001.

640443-001 Speaker cover for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish

640444-001 Plastics Kit (includes the service cover)

640445001 15.6-in, HD, LED, BrightView display panel

640447-001 Screw Kit

640448-001 Display Screw Kit

640449-001 Speaker Kit (includes left and right speakers and cable)

640450-001 System board for use only with computer models equipped with an AMD processor, the RS880M

chipset, a graphics subsystem with UMA memory, and USB version 2.0 (includes replacement
thermal material)

Sequential part number listing
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Spare part number

Description

640451001

System board for use only with computer models equipped with an AMD processor, the
RS880MD chipset, the HD6470 graphics subsystem chipset, 512-MB of graphics subsystem
discrete memory, and USB version 2.0 (includes replacement thermal material)

640452-001

System board for use only with computer models equipped with an AMD processor, the
RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB of graphics subsystem discrete
memory, and USB version 2.0 (includes replacement thermal material)

640453-001

System board for use only with computer models equipped with an AMD processor, the
RS880MD chipset, the HD6470 graphics subsystem chipset, 512-MB of graphics subsystem
discrete memory, and USB version 3.0 (includes replacement thermal material)

640454-001

System board for use only with computer models equipped with an AMD processor, the
RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB of graphics subsystem discrete
memory, and USB version 3.0 (includes replacement thermal material)

640455-001

System board for use only with computer models equipped with and AMD processor, the
RS880M chipset, a graphics subsystem with UMA memory, and USB version 3.0 (includes

replacement thermal material)

640456-001

Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory (includes replacement thermal paste and pads)

640457-001

Thermal Material Kit for use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory (includes replacement thermal paste and pads)

640458-001

Top cover in espresso black finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

640460001

Top cover in linen white finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

640461-001

Top cover in ruby red finish (includes TouchPad and TouchPad button board, but does not include
TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

640463-001

Top cover in dark umber finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

640926001

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter for use only with computer models
equipped with an AMD processor

641438001

Speaker cover for use only with computer models in dark umber and steel gray finish

641472-001

Display enclosure in Pacific blue finish

641473-001

Display enclosure in Sonoma red finish

641474-001

Display enclosure in pearl pink finish
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Spare part number

Description

641475001 Display enclosure in butter gold finish

641476-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with UMA memory (includes replacement thermal material)

641477-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with 1024-MB discrete memory (includes replacement thermal material)

641478-001 Bluetooth module cable (for use only with computer models equipped with an Intel processor)

641479-001 15.6-in, HD, LED, BrightView display assembly in Pacific blue finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

641480-001 15.6-in, HD, LED, BrightView display assembly in Sonoma red finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

641481-001 15.6-in, HD, LED, BrightView display assembly in pearl pink finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

641482-001 15.6-in, HD, LED, BrightView display assembly in butter gold finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

641484001 System board for use only with computer models equipped with an Intel dual core processor, the
Intel HD6490 graphics subsystem, 1024-MB of discrete memory, and USB version 3.0 (includes
replacement thermal material)

641485-001 System board for use only with computer models equipped with an Intel dual core processor, a
graphics subsystem with UMA memory, and USB version 3.0 (includes replacement
thermal material)

641486-001 System board for use only with computer models equipped with an Intel quad core processor, the
Intel HD6490 graphics subsystem, and 1024-MB of discrete memory (includes replacement
thermal material)

641487-001 System board for use only with computer models equipped with an Intel dual core processor, the
Intel HD6490 graphics subsystem, 1024-MB of discrete memory, and USB version 2.0 (includes
replacement thermal material)

641488001 System board for use only with computer models equipped with an Intel quad core processor, the
Intel HD6770 graphics subsystem, and 1024-MB of discrete memory (includes replacement
thermal material)

641489-001 System board for use only with computer models equipped with an Intel dual core processor, the
Intel HD6770 graphics subsystem, and 1024-MB of discrete memory (includes replacement
thermal material)

641490001 System board for use only with computer models equipped with an Intel dual core processor, a
graphics subsystem with UMA memory, and USB version 2.0 (includes replacement
thermal material)

641491-001 System board for use only with computer models equipped with an Intel quad core processor and
a graphics subsystem with UMA memory (includes replacement thermal material)

641492001 Thermal Material Kit for use only with computer models equipped with an Infel processor and a
graphics subsystem with UMA memory (includes replacement thermal paste and pads)

641493-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a

graphics subsystem with 1024-MB of discrete memory (includes replacement thermal paste
and pads)
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Spare part number

Description

641494-001 Top cover in Pacific blue finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)
NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

641495-001 Top cover in Sonoma red finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)
NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

641496001 Top cover in pearl pink finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)
NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

641497-001 Top cover in butter gold finish (includes TouchPad and TouchPad button board, but does not
include TouchPad cable or TouchPad button board cable)
NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.

641672-001 320-GB, 7200-rpm, 7.0 mm hard drive (2.5-in, SATA, does not include hard drive bracket,
hard drive connector cable, or screws)

641807-001 Display hinge covers

641809001 DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

641810001 Display Rubber Kit

641824-001 Blu-ray ROM with LightScribe DVD +R/RW Super Multi Double-Layer Drive (for use only with
computer models equipped with an Intel processor)

641825001 160-GB solid-state drive (for use only with computer models equipped with an Intel processor)

644362001 Display Cable Kit for use only with computer models in dark umber and steel gray finish (includes
display panel cable and webcam/microphone module cable)

644363001 Keyboard in silver finish for use with all computer models in the United States (includes
keyboard cable)

644363031 Keyboard in silver finish for use with all computer models in the United Kingdom and Singapore
(includes keyboard cable)

644363041 Keyboard in silver finish for use with all computer models in Germany (includes keyboard cable)

644363-051 Keyboard in silver finish for use with all computer models in France (includes keyboard cable)

644363-061 Keyboard in silver finish for use with all computer models in ltaly (includes keyboard cable)

644363071 Keyboard in silver finish for use with all computer models in Spain (includes keyboard cable)

644363-121 Keyboard in silver finish for use with all computer models in Canada (includes keyboard cable)

644363-131 Keyboard in silver finish for use with all computer models in Portugal (includes keyboard cable)

644363-141 Keyboard in silver finish for use with all computer models in Turkey (includes keyboard cable)
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Description

644363-161 Keyboard in silver finish for use with all computer models in Latin America (includes
keyboard cable)

644363-171 Keyboard in silver finish for use with all computer models in Saudi Arabia (includes
keyboard cable)

644363201 Keyboard in silver finish for use only with computer models equipped with an AMD processor
in Brazil (includes keyboard cable)

644363211 Keyboard in silver finish for use with all computer models in Hungary (includes keyboard cable)

644363-221 Keyboard in silver finish for use with all computer models in the Czech Republic and Slovakia
(includes keyboard cable)

644363-251 Keyboard in silver finish for use with all computer models in Russia (includes keyboard cable)

644363-281 Keyboard in silver finish for use only with computer models equipped with an Intel processor
in Thailand (includes keyboard cable)

644363-291 Keyboard in silver finish for use only with computer models equipped with an Intel processor
in Japan (includes keyboard cable)

644363-A41 Keyboard in silver finish for use with all computer models in Belgium (includes keyboard cable)

644363-AB1 Keyboard in silver finish for use only with computer models equipped with an Intel processor
in Taiwan (includes keyboard cable)

644363-AD1 Keyboard in silver finish for use only with computer models equipped with an Intel processor
in South Korea (includes keyboard cable)

644363-B31 Keyboard in silver finish for use with all computer models in the Netherlands (includes
keyboard cable)

644363-BA1 Keyboard in silver finish for use with all computer models in Slovenia (includes keyboard cable)

644363-BB1 Keyboard in silver finish for use only with computer models equipped with an Intel processor
in Israel (includes keyboard cable)

644363-BG1 Keyboard in silver finish for use with all computer models in Switzerland (includes
keyboard cable)

644363-DH1 Keyboard in silver finish for use with all computer models in Denmark, Finland, and Norway
(includes keyboard cable)

644363-D)1 Keyboard in silver finish for use with all computer models in Greece (includes keyboard cable)

650796-001 Display enclosure in steel gray finish

650797-001 Fan/heat sink assembly for use only with computer models equipped with an Intel processor and
a graphics subsystem with 2048-MB discrete memory (includes replacement thermal material)

650798-001 15.6-in, HD, LED, BrightView display assembly in steel gray finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

650799-001 System board for use only with computer models equipped with an Intel quad core processor and
the Intel HD6770 graphics subsystem with 2048-MB of discrete memory (includes replacement
thermal material)

650800-001 System board for use only with computer models equipped with an Intel dual core processor and

the Intel HD6770 graphics subsystem with 2048-MB of discrete memory (includes replacement
thermal material)
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650801-001 Thermal Material Kit for use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB of discrete memory (includes replacement thermal paste
and pads)

650802001 Top cover in steel gray finish (includes TouchPad and TouchPad button board, but does not

include TouchPad cable or TouchPad button board cable)

NOTE: The TouchPad cable and TouchPad button board cable are included in the Cable Kit,
spare part number 640422-001.
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

Flat-bladed screwdriver

®  Magnetic screwdriver

Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

E‘/fNOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

/\ CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to

the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

44

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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/\ CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described

in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by

different activities.

/\ CAUTION: A product can be degraded by as litle as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400V
Removing DIPS from plastic tube 2,000V 700V 400V
Removing DIPS from vinyl tray 11,500 V 4,000 vV 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

46

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastics Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V

Preliminary replacement requirements
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Component replacement procedures

This chapter provides removal and replacement procedures.

There are as many as 88 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw and screw lock size and location during removal
and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag.

?

® |

Serial: J000000CC  [ININWMRWWAMSmEN

—Product: XXXO0000C INMMEMEINNNNIN
L Warranty: 1y1yOy
| Model: 000000

Item

Component

Description

m

Product name

This is the product name affixed to the front of
the computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

3)

Part number/Product number (p/n)

This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

the computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the
base enclosure in the locations illustrated below.

i

I
T I
| I
I
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Battery

Description Spare part number
9-cell, 100-Whr, 3.00-Ah Li-ion battery 636631-001
6-cell, 62-Whr, 2.80-Ah Li-ion battery 593562-001
6-cell, 55-Whr, 2.55-Ah Li-ion battery 593554-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Slide the battery release latch (1) to release the battery.
2. Pivot the front edge of the battery (2) up and back.

3. Remove the battery (3) from the computer.
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To insert the battery:
1. Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery bay.

2. Pivot the front edge of the battery down into the battery bay until it is seated. (The battery release
latch will automatically lock into place.)

Optical drive

[/ NOTE:  The optical drive spare part kit includes a bezel and bracket.

Description Spare part number

Blu-ray ROM with LightScribe DVD +R/RW Super Multi Double-Layer Drive (for use only with 641824001
computer models equipped with an Intel processor)

DVD+RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 641809001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

Remove the optical drive:

1. Slide the service cover release latch to release the service cover.
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2. Llift the rear edge of the service cover up and forward until it rests at an angle.

3. Remove the service cover. The service cover is available in the Plastics Kit, spare part number
640444-001.

4. Remove the Phillips PM2.5x4.0 screw that secures the optical drive to the computer.

6. Ifitis necessary fo replace the optical drive bracket, position the optical drive with the rear panel
toward you.
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7. Remove the two Phillips PM2.0x4.0 screws (1) that secure the bracket to the optical drive.

8. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.

Component replacement procedures 53



Hard drive

@NOTE: The hard drive and solid-state drive spare part kit does not include the bracket, connector
cable, or screws. The bracket and screws are included in the Hard Drive Hardware Kit, spare part
number 640428-001. The connector cable is included in the Cable Kit, spare part number

640422-001.
Description Spare part number
1-TB, 5400-rpm, 12.7 mm 638974-001
750-GB, 7200-rpm, 9.5 mm 633252001
750-GB, 5400-rpm, 9.5 mm 634250-001
640-GB, 7200-rpm, 9.5 mm 621046-001
500-GB, 7200-rpm, 9.5 mm 608218-001
320-GB, 7200-rpm, 7.0 mm 641672001 and
634862-001
250-GB, 7200-rpm, 7.0 mm 635225-001 and
634861-001
160-GB solid-state drive (for use only with computer models equipped with an Intel processor) 641825-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Optical drive on page 51).

Remove the hard drive:
1. Disconnect the hard drive connector cable (1) from the system board.

2. Remove the four Phillips PM2.5x4.0 screws (2) that secure the hard drive to the computer.
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3. Use the Mylar tab built into the hard drive bracket to lift and remove the hard drive (3) from
the computer.

4. Ifitis necessary fo replace the hard drive connector cable or hard drive bracket:

a. Remove the four Phillips PM3.0x4.0 screws (1) that secure the hard drive bracket to the
hard drive.

b. Remove the hard drive bracket (2) from the hard drive.

c. Disconnect the hard drive connector cable (3) from the hard drive.

@ o['/

Reverse this procedure to reassemble and install the hard drive.

Component replacement procedures

55



RTC battery

Description Spare part number

RTC battery 608771-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Optical drive on page 51).

Remove the RTC battery:

A Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Memory module

Description Spare part number
4-GB (DDR3, 10600, 1333-MHz) 621569-001
2-GB (DDR3, 10600, 1333-MHz) 621565-001
1-GB (DDR3, 10600, 1333-MHz) 639736-001

Before removing a memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Optical drive on page 51).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2. Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.
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WLAN module

Description Spare part number

For use on all computer models:

Broadcom 4313 802.11b/g/n 1x1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter 600370-001
(BT3.0+HS ready)

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
Ralink RT3090BC4 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter 630705-001

(BT3.0+HS ready)

Ralink 5390GN 802.11b/g/n 1x1 WiFi Adapter 630703-001

For use only with computer models equipped with an AMD processor:

Atheros 9285G 802.11b/g/n 1x1 WiFi Adapter 605560-005
Atheros ARBO02WB-TNGB 802.11b/g/n 1x1 WiFi and Bluetooth 2.1+EDR Combo Adapter 593127-001
(BT3.0+HS ready)

Realtek RTL8191SE 802.11b/g/n 1x1 WiFi Adapter 640926-001
Realtek 8188BC8 802.11a/b/g/n 2x2 WiFi and Bluetooth 3.0+HS Combo Adapter 602993-001

For use only with computer models equipped with an Intel processor:

Intel Centrino Advanced-N 6230 631956-001
Intel Centrino Wireless-N 1000 593530-001
Intel Centrino Wireless-N + WiMAX 6150 633817-001

/\ CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Optical drive on page 51).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables from the terminals on the WLAN module.

@NOTE: The #1/black WLAN antenna cable is connected to the WLAN module Main terminal.
The #2/gray WLAN antenna cable is connected to the WLAN module Aux terminal.

2. Remove the two Phillips PM2.0x4.0 screws that secure the WLAN module to the system board.
(The WLAN module tilts up.)

3. Remove the WLAN module by pulling the module away from the slot at an angle.
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@NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Keyboard

E"%NOTE: The keyboard spare part kit includes a keyboard cable.

Description

Spare part number

Description

Spare part number

Keyboard in black finish:

For use only with computer models ~ 640436-201 For use only with computer models ~ 640436-AD1
equipped with an AMD processor equipped with an Intel processor
in Brazil in South Korea
For use only with computer models ~ 640436-BB1 For use only with computer models 640436-AB1
equipped with an Intel processor equipped with an Intel processor
in Israel in Taiwan
For use only with computer models ~ 640436-291 For use only with computer models ~ 640436-281
equipped with an Intel processor equipped with an Intel processor
in Japan in Thailand
For use with all computer models 640436-A41 For use with all computer models 640436-B31
in Belgium in the Netherlands
For use with all computer models 640436-121 For use with all computer models 640436-131
in Canada in Portugal
For use with all computer models 640436-221 For use with all computer models 640436-251
in the Czech Republic and Slovakia in Russia
For use with all computer models 640436-DH1 For use with all computer models 640436-171
in Denmark, Finland, and Norway in Saudi Arabia
For use with all computer models 640436-051 For use with all computer models 640436-BA1
in France in Slovenia
For use with all computer models 640436-041 For use with all computer models 640436-071
in Germany in Spain
For use with all computer models 640436-D1 For use with all computer models 640436-BG1
in Greece in Switzerland
For use with all computer models 640436211 For use with all computer models 640436-141
in Humgary in Turkey
For use with all computer models 640436061 For use with all computer models 640436-031
in ltaly in the United Kingdom
and Singapore

For use with all computer models 640436-161 For use with all computer models 640436-001
in Latin America in the United States

Keyboard in silver finish:
For use only with computer models ~ 644363-201 For use only with computer models ~ 644363-AD1
equipped with an AMD processor equipped with an Intel processor
in Brazil in South Korea
For use only with computer models ~ 644363-BB1 For use only with computer models ~ 644363-AB1

equipped with an Intel processor
in Israel

equipped with an Intel processor
in Taiwan
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Description Spare part number

Description

Spare part number

For use only with computer models ~ 644363-291 For use only with computer models ~ 644363-281
equipped with an Intel processor equipped with an Intel processor
in Japan in Thailand
For use with all computer models 644363-A41 For use with all computer models 644363831
in Belgium in the Netherlands
For use with all computer models 644363-121 For use with all computer models 644363-131
in Canada in Portugal
For use with all computer models 644363-221 For use with all computer models 644363-251
in the Czech Republic and Slovakia in Russia
For use with all computer models 644363-DH1 For use with all computer models 644363-171
in Denmark, Finland, and Norway in Saudi Arabia
For use with all computer models 644363051 For use with all computer models 644363-BA1
in France in Slovenia
For use with all computer models 644363-041 For use with all computer models 644363-071
in Germany in Spain
For use with all computer models 644363-D)1 For use with all computer models 644363BG1
in Greece in Switzerland
For use with all computer models 644363-211 For use with all computer models 644363-141
in Humgary in Turkey
For use with all computer models 644363-061 For use with all computer models 644363-031
in ltaly in the United Kingdom

and Singapore
For use with all computer models 644363-161 For use with all computer models 644363-001

in Latin America

in the United States

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50).

5. Remove the service cover (see Optical drive on page 51).
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Remove the keyboard:

1. Remove the Phillips PM2.5x4.0 screw that secures the keyboard to the computer.

2. Rest the computer on its left side.

3. Open the computer.

4. Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5. Turn the computer rightside up with the front toward you.
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6. Llift the rear edge (1) of the keyboard, and then slide the keyboard (2) back until the keyboard
cable is accessible.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top

cover

E’%NOTE: The top cover spare part kit includes the TouchPad and TouchPad button board, but does not
include the TouchPad cable or TouchPad button board cable. The TouchPad cable and TouchPad
button board cable are included in the Cable Kit, spare part number 640422-001.

Description Spare part number
In butter gold finish 641497001
In dark umber finish 640463-001
In espresso black finish 640458-001
In linen white finish 640460001
In Pacific blue finish 641494-001
In pearl pink finish 641496-001
In ruby red finish 640461-001
In Sonoma red finish 641495001
In steel gray finish 650802001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

Hard drive (see Hard drive on page 54)

Keyboard (see Keyboard on page 61)

E’%NOTE: When replacing the top cover, be sure that the power button board and cable (see Power

button board on page 69) and fingerprint reader board and cable (see Fingerprint reader board
on page 71) are removed from the defective top cover and installed on the replacement top cover.

Remove the top cover:
1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Remove the seven Phillips PM2.5x10.0 screws that secure the top cover to the computer.

4. Remove the following screws that secure the top cover to the computer:
e Three Phillips PM2.0x3.0 screws (1) in the optical drive bay
e Three Phillips PM2.5%6.0 screws (2)
e  One Phillips PM2.0x4.0 screw (3) in the hard drive bay

5. Turn the computer rightside up, with the front toward you.

6. Open the computer.
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7.

8.

9.

Release the ZIF connectors to which the following cables are attached, and then disconnect the
cables from the system board:

@NOTE: The power button board cable, TouchPad button board cable, and fingerprint reader
board cable are included in the Cable Kit, spare part number 640422-001.

e  Power button board cable (1)

e  TouchPad button board cable (2)

e  Fingerprint reader board cable (3) (select models only)

Remove the seven Phillips PM2.5x6.0 screws that secure the top cover to the computer.

Lift the rear edge of the top cover (1) until the left and right sides disengage from the
base enclosure.
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10. Remove the top cover (2).

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (does not include cable) 640439-001

NOTE: The power button board cable is not included in the power button board spare part kit. The
power button board cable is included in the Cable Kit, spare part number 640422-001.

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e  Hard drive (see Hard drive on page 54)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

Remove the power button board:
1. Turn the top cover upside down, with the front toward you.
2. Release the power button board cable from the clip (1) built into the top cover.

3. Remove the three Phillips PM2.0x4.0 screws (2) that secure the power button board to the
top cover.
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4. Remove the power button board and cable (3).

Reverse this procedure to install the power button board and cable.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (select models only, includes bracket, but does not include cable) 640427-001

NOTE: The fingerprint reader board cable is not included in the fingerprint reader board spare
part kit. The fingerprint reader board cable is included in the Cable Kit, spare part number
640422-001.

Before removing the fingerprint reader board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e  Hard drive (see Hard drive on page 54)

e  Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

Remove the fingerprint reader board and cable:
1. Turn the top cover upside down, with the front toward you.
2. Release the fingerprint reader board cable (1) from the clips (2) built into the top cover.

3. Remove the two Phillips PM2.0x4.0 screws (3) that secure the fingerprint reader board and
bracket to the top cover.
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4. Remove the fingerprint reader board bracket (4) and the fingerprint reader board (5).

Reverse this procedure to install the fingerprint reader board and cable.
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Bluetooth module

E’%NOTE: This section applies only to computer models equipped with an Intel processor.

Description Spare part number

Bluetooth module 537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is available in the Cable Kit, spare part number 640422-001.

Before removing the Bluetooth module and cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)
e  Hard drive (see Hard drive on page 54)
e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

Remove the Bluetooth module and cable:
1. Disconnect the Bluetooth module cable (1) from the system board.

2. Release the Bluetooth module cable from the clips (2) and the routing channel built into the front
speaker assembly.
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3. Release the Bluetooth module (3) from the clip built into the front speaker assembly.

NS R
& e

4. Remove the Bluetooth module and the Bluetooth module cable.

5. Ifitis necessary to replace the Bluetooth module cable, disconnect the cable from the Bluetooth
module and replace it.

H"h—

N

Reverse this procedure to install the Bluetooth module and cable.
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USB board

Description Spare part number

USB board (does not include cable) 640441-001

NOTE: The USB board cable is not included in the USB board spare part kit. The USB board cable
is included in the Cable Kit, spare part number 640422-001.

Before removing the USB board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

®  Hard drive (see Hard drive on page 54)

e  Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

Remove the USB board and cable:

1. Release the ZIF connector to which the USB board cable is connected, and then disconnect the
USB board cable (1) from the system board.

2. Remove the Phillips PM2.5x5.0 screw (2) that secures the USB board to the base enclosure.

3. Remove the USB board (3) and cable.
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Reverse this procedure to install the USB board.

Power connector cable

Description Spare part number

Power connector cable 640424-001

Before removing the power connector cable, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e Hard drive (see Hard drive on page 54)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

e  USB board (see USB board on page 75)

Remove the power connector cable:
1. Disconnect the power connector cable (1) from the system board.
2. Release the power connector cable from the clips (2) built into the base enclosure.

3. Remove the two Phillips PM2.0x2.0 screws (3) that secure the power connector to the
base enclosure.
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4. Remove the power connector (4) from the base enclosure.

Reverse this procedure to install the power connector cable.
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System board

@NOTE: The system board spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

e 640457-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

e 640456-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

e 650801-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB of discrete memory

e 641493-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB of discrete memory

e 641492-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number

For use only with computer models equipped with an AMD processor:

Equipped with the RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB of graphics 640454-001
subsystem discrete memory, and USB version 3.0

Equipped with the RS880MD chipset, HD6650 graphics subsystem chipset, 1024-MB of graphics 640452-001
subsystem discrete memory, and USB version 2.0

Equipped with the RS880MD chipset, HD6470 graphics subsystem chipsetf, 512-MB of graphics 640453-001
subsystem discrete memory, and USB version 3.0

Equipped with the RS880MD chipset, HD6470 graphics subsystem chipsetf, 512-MB of graphics 640451-001
subsystem discrete memory, and USB version 2.0

Equipped with the RS880M chipset, a graphics subsystem with UMA memory, and USB version 3.0~ 640455-001

Equipped with the RS880M chipset, a graphics subsystem with UMA memory, and USB version 2.0~ 640450-001

For use only with computer models equipped with an Intel processor:

For use only with computer models equipped with a quad core processor and the Intel HD6770 650799-001
graphics subsystem with 2048-MB of discrete memory

For use only with computer models equipped with a dual core processor and the Intel HD6770 650800-001
graphics subsystem with 2048-MB of discrete memory

For use only with computer models equipped with a quad core processor and the Intel HD6770 641488-001
graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with a dual core processor and the Intel HD6770 641489-001
graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with a quad core processor and the Intel HD6490 641486001
graphics subsystem with 1024-MB of discrete memory

For use only with computer models equipped with a dual core processor, the Intel HD6490 graphics  641484-001
subsystem, 1024-MB of discrete memory, and USB version 3.0
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Description Spare part number

For use only with computer models equipped with a dual core processor, the Intel HD6490 graphics  641487-001
subsystem, 1024-MB of discrete memory, and USB version 2.0

For use only with computer models equipped with a quad core processor, a graphics subsystem with  641491-001
UMA memory, and USB version 3.0

For use only with computer models equipped with a dual core processor, a graphics subsystem with ~ 641485-001
UMA memory, and USB version 3.0

For use only with computer models equipped with a dual core processor, a graphics subsystem with ~ 641490-001
UMA memory, and USB version 2.0

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e  Hard drive (see Hard drive on page 54)

e  WIAN module (see WLAN module on page 58)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

®  RTC battery (see RTC battery on page 56)

®  Memory module (see Memory module on page 57)

e  Fan and heat sink (see Fan/heat sink assembly on page 82)

®  Processor (see Processor on page 86)

Remove the system board:
1. Close the computer.

2. Turn the computer upside down, with the font toward you.
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3. Disconnect the speaker cable (1) and the optical drive connector cable (2) from the system board.

4. Turn the computer right side up, with the front toward you.
5. Open the computer.
6. Disconnect the following cables from the system board:

e Display panel cable (1)

e Webcam/microphone cable (2)

e  Bluetooth module cable (3)

e USB board cable (4)

®  Power connector cable (5)
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7. Remove the Phillips PM2.5%4.0 screw (1) and the two Phillips PM2.5x5.0 screws (2) that secure
the system board to the base enclosure.

8. Flex the left side of the base enclosure (1) outward to provide clearance for the audio
connectors (2) and the other connectors on the left side of the system board.

9. Lift the front edge of the system board (3) until it rests at an angle.

10. Remove the system board (4) by sliding it up and forward at an angle.

Reverse this procedure fo install the system board.
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Fan/heat sink assembly

@NOTE: The fan/heat sink assembly spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

e 640457-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

e 640456-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

e 650801-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB of discrete memory

e 641493-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB of discrete memory

e 641492-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number

For use only with computer models equipped with an AMD processor:

For use only with computer models equipped with a graphics subsystem with discrete memory 640426-001

For use only with computer models equipped with a graphics subsystem with UMA memory 640425-001

For use only with computer models equipped with an Intel processor:

For use only with computer models equipped with a graphics subsystem with 2048-MB 650797-001
discrete memory

For use only with computer models equipped with a graphics subsystem with 1024-MB 641477-001
discrete memory

For use only with computer models equipped with a graphics subsystem with UMA memory 641476-001

@NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of
the computer. the computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e  Hard drive (see Hard drive on page 54)

e WILAN module (see WLAN module on page 58)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

e  System board (see System board on page 78)

Remove the fan/heat sink assembly:

1. Disconnect the fan cable from the system board.

n W 4 ¢ N

2. Turn the system board upside down, with the fan away from you.

3. Loosen the captive screws (1) that secure the fan/heat sink assembly to the system board.

@NOTE: The number of screws used to secure the fan/heat sink assembly to the system board
varies by computer model.

@NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.
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4. Remove the fan/heat sink assembly (2).

E"%NOTE: The following illustration shows the fan/heat sink assembly being removed from a
computer model equipped with an AMD processor and a graphics subsystem with
discrete memory. A computer model equipped with an AMD processor and a graphics subsystem
with UMA memory has only four screws.

E%?NOTE: The following illustration shows the fan/heat sink assembly being removed from a
computer model equipped with an Intel processor and a graphics subsystem with discrete memory.
A computer model equipped with an Intel processor and a graphics subsystem with UMA memory
has only four screws.
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The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system
board components each time the fan/heat sink assembly is removed. Replacement thermal material is
included with the fan/heat sink assembly, processor, and system board spare part kits.

Replacement thermal material is also available in the Thermal Material Kit.

E’/f’NOTE: The following illustration shows the replacement thermal material locations on a computer
model equipped with an AMD processor and a graphics subsystem with discrete memory.

e Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with discrete memory)

e A thermal pad is used on the Northbridge chip (5) and the heat sink section (6) that services it

—] ¢
l:y:l
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E‘/f'NOTE: The following illustration shows the replacement thermal material locations on a computer
model equipped with an Intel processor and a graphics subsystem with discrete memory.

e  Thermal paste is used on the processor (1) and the heat sink section (2) that services it

e Athermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it (only on computer models equipped with a graphics subsystem with discrete memory)

e Athermal pad is used on the Northbridge chip (5) and the heat sink section (6) that services it
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Reverse this procedure to reassemble and install the fan/heat sink assembly.

Processor

@NOTE: The processor spare part kit includes replacement thermal material.
Replacement thermal material is also available in the Thermal Material Kit, using the following spare
part numbers:

e 640457-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with discrete memory

e 640456-001 — For use only with computer models equipped with an AMD processor and a
graphics subsystem with UMA memory

e 650801-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 2048-MB of discrete memory

e  641493-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with 1024-MB of discrete memory

e 641492-001 — For use only with computer models equipped with an Intel processor and a
graphics subsystem with UMA memory

Description Spare part number
AMD Athlon Il N370 2.50-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core, 634686-001

35 W)

AMD Athlon Il P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core, 636635-001

25 W)

AMD Athlon Il P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core, 616343-001

25 W)

AMD Phenom Il N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec, quad core,  635496-001
35W)

AMD Phenom Il N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, friple core, ~ 635495-001
35W)
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Description

Spare part number

AMD Phenom Il N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, triple core, 616345-001
35W)

AMD Phenom Il N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec, dual core, 635494-001
35W)

AMD Phenom Il P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, quad core, 634689-001
25 W)

AMD Phenom Il P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, triple core, 634688-001
25 W)

AMD Phenom Il P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, triple core, 634687-001
25 W)

AMD Turion Il P570 2.70-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core, 634690-001
35W)

AMD Turion Il P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core, 634691-001
25 W)

Intel Core i7-2820M 2.30-GHz (SC turbo up to 3.10-GHz) processor (8.0-MB L3 cache, 634694-001
quad core, 45 W)

Intel Core i7-2720M 2.20-GHz (SC turbo up to 3.00-GHz) processor (6.0-MB L3 cache, 631254-001
quad core, 45 W)

Intel Core i7-2630M 2.00-GHz (SC turbo up to 2.90-GHz) processor (6.0-MB L3 cache, 635501-001
quad core, 45 W)

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB L3 cache, 631252-001
dual core, 35 W)

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache, 631255-001
dual core, 35 W)

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache, 631253-001
dual core, 35 W)

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB L3 cache, 638039-001
dual core, 35 W)

Intel Core i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W) 638037-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e Optical drive (see Optical drive on page 51)

e  Hard drive (see Hard drive on page 54)

e WILAN module (see WLAN module on page 58)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

e  System board (see System board on page 78)

e  Fan/heat sink assembly (see Fan/heat sink assembly on page 82)

Remove the processor:

1. Use a flat-bladed screw driver to turn the processor locking screw one-half turn
counterclockwise (1), until you hear a click.
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2. Lift the processor (2) straight up, and remove it.

@NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.

@NOTE: The following illustration shows the processor removal process on a computer model
equipped with an AMD processor.

@NOTE: The following illustration shows the processor removal process on a computer model
equipped with an Intel processor.

Reverse this procedure to install the processor.
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Speakers

Description Spare part number

Speaker cover:

For use only with computer models in dark umber and steel gray finish 641438-001

For use only with computer models in butter gold, espresso black, linen white, Pacific blue, pearl 640443-001
pink, ruby red, and Sonoma red finish

Speaker Kit (includes left and right speakers and cable) 640449-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 50), and then remove the following components:

e  Optical drive (see Optical drive on page 51)

e Hard drive (see Hard drive on page 54)

e Keyboard (see Keyboard on page 61)

®  Top cover (see Top cover on page 65)

e  System board (see System board on page 78)

Remove the speakers:
1. Close the computer.

2. Turn the computer upside down, with the front toward you.
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3. Release the rear speaker cable (1) from the clips (2) and routing channel built into the
base enclosure.

4. Remove the four Phillips PM2.5x4.0 screws (1) and the PM2.5x10.0 screw (2) that secure the
rear speaker to the computer.

5. Turn the computer right side up, with the front toward you.

6. Open the computer.

7. Release the rear speaker cable (1) from the opening in the base enclosure and the clips (2) and
(3) built into the base enclosure.
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8. Remove the rear speaker (4) and cable.

9. Remove the Phillips PM2.5x4.0 screw (1) that secures the front speaker to the base enclosure.

10. Remove the front speaker (2).

@?NOTE: When removing the front speaker, note the installation locations of two isolators (3).

Reverse this procedure to install the speakers.
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Optical drive connector cable

[ NOTE:  The optical drive connector cable is included in the Cable Kit, spare part number
640422-001. The optical drive connector cable includes the optical drive connector.

Before removing the optical drive connector cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 50), and then remove the following components:

Optical drive (see Optical drive on page 51)

Hard drive (see Hard drive on page 54)

Keyboard (see Keyboard on page 61)

Top cover (see Top cover on page 65)

System board (see System board on page 78)

Remove the optical drive connector cable:

1.
2.
3.

Close the computer.

Turn the computer upside down, with the front toward you.

Release the optical drive connector cable (1) from the clips (2) and routing channel built into the
base enclosure.
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Turn the computer right side up, with the front toward you.
Open the computer.

Release the optical drive connector cable from the clips (1) built into the base enclosure.

N oo ou »

Remove the two Phillips PM2.0x7.0 screws (1) that secure the optical drive connector to the
base enclosure.

8. Remove the optical drive connector cable (3).

Reverse this procedure to install the optical drive connector cable.

Display assembly

Y NOTE: The display assembly includes a webcam, two microphones, and wireless antenna
transceivers and cables.

Description Spare part number

15.6-in, HD, LED, BrightView display assembly

In butter gold finish 641482001
In dark umber finish 640431-001
In espresso black finish 640430001
In linen white finish 640433001
In Pacific blue finish 641479001
In pearl pink finish 641481001
In ruby red finish 640434-001
In Sonoma red finish 641480001
In steel gray finish 650798-001
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Before removing the display assembly, follow these steps:

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn

the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

1.

2,

3.

4.
.
.
.
.
.
°

Remove the battery (see Battery on page 50), and then remove the following components:

Optical drive (see Optical drive on page 51)

Hard drive (see Hard drive on page 54)

WLAN module (see WLAN module on page 58)

Keyboard (see Keyboard on page 61)

Top cover (see Top cover on page 65)

System board (see System board on page 78)

Remove the display assembly:

1.

2,

3.

Release the wireless antenna cables from the clips (1) and the opening in the base enclosure.

/\ CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.

Remove the six Phillips PM2.5x5.0 screws (2) that secure the display assembly to the computer.

r__f/fNOTE: The left-most screw on the left hinge secures a display panel cable ground loop (3).

Remove the display assembly (4).
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4. Ifitis necessary to replace the display bezel or any of the display assembly subcomponents:

a. Remove the two screw covers (1) and the two Phillips PM2.5x5.0 screws (2) that secure the
display bezel to the display assembly. (The screw covers are available in the Display Rubber
Kit, spare part number 641810-001.)
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b. Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel (4). The display bezel is available using spare part numbers
640421-001 (for use only with computer models in dark umber and steel gray finish) and
640420-001 (for use only with computer models in butter gold, espresso black, linen white,
Pacific blue, pearl pink, ruby red, and Sonoma red finish).
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5. [Ifitis necessary fo replace the webcam/microphone module:

a. Detach and release the webcam/microphone module (1) as far as the webcam/microphone
module cable allows. (The webcam/microphone module is attached to the display enclosure
with double-sided tape.)

b. Disconnect the webcam/microphone module (2) from the webcam/microphone module.

c. Remove the webcam/microphone module (3). The webcam/microphone module is available
using spare part number 639387-001.

6. Ifitis necessary fo replace the hinge covers:

a. Remove the two Phillips PM2.0x3.0 (1) screws that secure the hinge covers to the
display enclosure.
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b. Remove the hinge covers (2). The hinge covers are available using spare part number
641807-001.

7. Ifitis necessary to replace the display panel:

a. Remove the two Phillips PM2.5x3.5 (1) screws and the six Phillips PM2.5x5.0 screws (2)
that secure the display panel to the display enclosure.
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b.

Lift the top edge of the display panel (1), and then swing it forward (2) until it rests upside
down in front of the display enclosure.

Release the adhesive strips (1) and (2) that secure the display panel cable to the display
panel, and then disconnect the display panel cable (3) from the display panel.

Remove the display panel. The display panel is available using spare part number
640445-001.
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8. Ifitis necessary to replace the display hinges:

a. Remove the eight Phillips PM2.0x2.0 screws (1) that secure the display hinges to the
display panel.

b. Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 640429-001.

os&;-

9. Ifitis necessary to replace the display panel cable:

a. Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

b. Release the display panel cable from the clips (2) built into the display enclosure.

c. Remove the display panel cable. The display panel cable includes the webcam/microphone
module cable and is available in the Display Cable Kit, spare part numbers 644362-001 (for
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use only with computer models in dark umber and steel gray finish) and 640423-001 (for
use only with computer models in butter gold, espresso black, linen white, Pacific blue, pearl
pink, ruby red, and Sonoma red finish).

10. If it is necessary to replace the wireless antenna cables and transceivers:

a. Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the wireless antenna cables from the clips (2) built into the display enclosure.

¢. Remove the wireless antenna cables and transceivers (3). The wireless antenna cables and
transceivers are available in the Antenna Kit, spare part number 640411-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility

Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
includes settings for the types of peripherals installed, the startup sequence of the computer, and the
amount of system and extended memory.

@NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer from
operating properly.

Starting Setup Utility

@NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only if
USB legacy support is enabled.

To start Setup Utility, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press {10 to enter Setup Utility.

Changing the language of Setup Utility
1. Start Setup Utility.

Use the arrow keys to select System Configuration > Language, and then press enter.

2

3. Use the arrow keys to select a language, and then press enter.

4. When a confirmation prompt with your language selected is displayed, press enter.
5

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility

To navigate and select in Setup Utility, follow these steps:

1.

2,

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press entfer, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

® To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

@NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the

keyboard to navigate and make selections in Setup Utility.

Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:

To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—Oor —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information

1.
2,

Start Setup Utility.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility

@NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Setup Utility to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press {10 to enter Setup Utility.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

b

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

@NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility
e  To exit Setup Utility and save your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Saving Changes, and then press enter.

e To exit Setup Utility without saving your changes from the current session:

If the Setup Utility menus are not visible, press esc to return to the menu display. Then use the
arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS

Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPags.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility.

1. Start Setup Utility.
2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of the
screen, and then follow the on-screen instructions.

— or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

Downloading a BIOS update

/\ CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Windows 7—Select Start > Help and Support > Maintain.

Windows XP—Select Start > Help and Support, and then select the software and
drivers update.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. At the download areq, follow these steps:

a. Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b. Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.

E/E’NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.
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BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:

1. Windows 7—Open Windows Explorer by selecting Start > Computer.
Windows XP—Open Windows Explorer by selecting Start > My Computer.
2. Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3. Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4. Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5. Complete the installation by following the on-screen instructions.

[Bf NOTE:  After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using System Diagnostics

System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:

e  Start-up test—This test analyzes the main computer components that are required to start
the computer.

®  Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

e Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

®  Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

e  Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact HP
support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.
To start System Diagnostics:

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press 2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

E/?’NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions
Depth 24.7 cm 9.72in
Width 37.8 cm 14.88 in
Height (front to back) 3.1103.5cm 1.2310 1.39in
Weight 2.91 kg 6.42 b
Input power
Operating voltage 185Vdc@3.5A-65W,; 19Vdc@4.74 A-90 W, or
185Vdc@65A-120W
Operating current 3.5,4.74,0r6.5A
Temperature
Operating 5°Cto 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15mto 3,048 m -50 ft to 10,000 ft

Nonoperating -15mto 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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15.6-inch display specifications
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Metric u.s.
Dimensions
Height 19.6 cm 7.72in
Width 34.7 cm 13.66in
Diagonal 39.8 cm 15.67 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch

0.197 X 0.197 mm

Format

1366 x 768

Configuration

RGB vertical stripe

Backlight LED
Character display 80 x 25
Total power consumption 2.0W

Viewing angle

+65° horizontal, +50° vertical (typical)
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Hard drive specifications

1-TB* 750-GB** 640-GB**
Dimensions
Height 12.7 mm 9.5 mm 9.5 mm
Length 100.2 mm 100.2 mm 100.2 mm
Width 69.9 mm 69.9 mm 69.9 mm
Weight 152 g 110g 98g
Interface type SATA (3 GB/sec) SATA (3 GB/sec) SATA
Transfer rate
Synchronous (maximum) 97 MB/sec 97 MB/sec 106 MB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 2.0 ms 2.0 ms 1.5 ms
Average (read/write) 12/16 ms 12/16 ms 12/13 ms
Maximum 21 ms 21 ms 24 ms

Logical blocks

1,953,525, 168

1,465,149,168

1,250,263,728

Disk rotational speed 5400 RPM 7200 and 5400 rpm 7200 rpm

Operating temperature 0°Cto 60°C (32°F to 140°F)

*1 TB = 1 trillion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

**1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Cerfain restrictions and exclusions apply. Contact technical support for details.
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Hard drive specifications (continued)

500-GB* 320-GB* 250-GB*
Dimensions
Height 9.5 mm 7.0 mm 7.0 mm
Length 100.4 mm 100.4 mm 100.4 mm
Width 69.9 mm 69.9 mm 69.9 mm
Weight 110g¢g 110 g 105¢g
Interface type SATA SATA SATA
Transfer rate
Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec
Security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 1.5 ms 1.5 ms 1.5 ms
Average (read/write) 11/13 ms 11/13 ms 11/13 ms
Maximum 22 ms 22 ms 22 ms
Logical blocks 976,773,168 628,142,448 488,397,168
Disk rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.

This chapter provides information on the following topics:

e  Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)
e  Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

®  Backing up your information

®  Recovering a program or driver

Restore

In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash drive
immediately after software setup.

If for some other reason you need to restore your system, this can be achieved using the HP Recovery
partition (select models only), without the need for recovery discs or a recovery flash drive. To check for
the presence of a recovery partition, click Start, right-click Computer, click Manage, and then click
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.

/\ CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.

E’/fNOTE: Recovery discs have been included if your computer does not have a recovery partition.
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Creating restore media

112

HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason you
cannot restore using the recovery partition tools. Create these discs or the flash drive after setting up
the computer for the first time.

@NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery

flash drive. Handle these discs or flash drive carefully and keep them in a safe place.

@NOTE: If your computer does not include an integrated optical drive, you can use an optional

external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be connected
directly to a USB port on the computer, not to a USB port on an external device, such as a USB hub.

Guidelines:

®  Purchase high-quality DVDR, DVD+R, DVD-R DL, or DVD+R DL discs.

E’/fNOTE: Read-write discs, such as CD-RW, DVD+RW, double-layer DVD+RW, and BD-RE

(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

e the computer must be connected to AC power during this process.

®  Only one set of recovery discs or one recovery flash drive can be created per computer.

[Bf NOTE: If you are creating recovery discs, number each disc before inserting into the optical
drive.

e  If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to continue
the backup creation process.

To create a set of recovery discs or a recovery flash drive:
1. Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2. Follow the on-screen instructions.
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Performing a system restore

Recovery Manager software allows you to repair or restore the computer fo its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.

E’%NOTE: A system restore needs to be performed if the computer hard drive has failed or if all attempts
to correct any functional computer issues fail.

A system restore should be used as a final attempt to correct computer issues. Note the following when
performing a system restore:

®  You can restore only the system that you have previously backed up. HP recommends that you use
HP Recovery Manager fo create either a set of recovery discs or a recovery flash drive as soon as
you set up the computer.

e  Windows has its own built-in repair features, such as System Restore. If you have not already tried
these features, try them before using Recovery Manager.

®  Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition
(select models only)

When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.

To restore the computer from the recovery partition, follow these steps:
1. Access Recovery Manager in either of the following ways:
e  Select Start > All Programs > Recovery Manager > Recovery Manager.
—or—

e  Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press {11 while the “F11
(System Recovery)” message is displayed on the screen.

2. Click System Recovery in the Recovery Manager window.

3. Follow the on-screen instructions.

Performing a system restore 113



Restoring using the restore media

1. If possible, back up all personal files.

2. Insert the first recovery disc into the optical drive on your computer or an optional external optical
drive, and then restart the computer.

—or —

Insert the recovery flash drive into a USB port on your computer, and then restart the computer.

E’/fNOTE: It the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3. Press {9 at system bootup.
4. Select the optical drive or the flash drive.

5. Follow the on-screen instructions.

Changing the computer boot order

To change the boot order for recovery discs:

1. Restart the computer.

2. Press esc while the computer is restarting, and then press {9 for boot options.
3. Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:

1. Insert the flash drive into a USB port.

Restart the computer.

Press esc while the computer is restarting, and then press {9 for boot options.

Ll S

Select the flash drive from the boot options window.
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Backing up and recovering your information

It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.

How completely you are able to recover your system depends on how recent your backup is.

E‘jNOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted.

You can back up your information to an optional external hard drive, a network drive, or discs. Back
up your system at the following times:

e  Atregularly scheduled times

-<?- TIP: Set reminders to back up your information periodically.

e  Before the computer is repaired or restored
e  Before you add or modify hardware or software
Guidelines:

e  Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

®  Store personal files in the Documents library and back up this folder periodically.

®  Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. the screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste. the screen image is added to
the document.

4. Save and print the document.
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Using Windows Backup and Restore

Guidelines:
®  Be sure that the computer is connected to AC power before you start the backup process.

e Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:
1. Select Start > Control Panel > System and Security > Backup and Restore.

2. Follow the on-screen instructions to schedule and create a backup.

@NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points

A system restore point allows you to save and name a snapshot of your hard drive at a specific point in
time. You can then recover back to that point if you want to reverse subsequent changes.

@NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.

You also can create additional restore points to provide increased protection for your files and settings.

When to create restore points
e  Before you add or modify software or hardware

e  Periodically, whenever the computer is functioning optimally

@NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point

1. Select Start > Control Panel > System and Security > System.
In the left pane, click System Protection.

Click the System Protection tab.

P @ N

Follow the on-screen instructions.

Restore to a previous date and time

To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:

1. Select Start > Control Panel > System and Security > System.
In the left pane, click System Protection.
Click the System Protection tab.

Click System Restore.

L S A

Follow the on-screen instructions.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries

The following requirements are applicable to all countries and regions:
e  The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e  The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China cocC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conducfor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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9 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/\ WARNING! The backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.

/\ CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

@NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

g -

E/%"NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

u
o\

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

/\ WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

124 Chapter 9 Recycling



18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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AC adapter, spare part numbers
31,33
Action keys 11
antenna
locations 8
removal 101
spare part number 28, 35,
101
Antenna Kit, spare part number
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audio-in jack 14
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power 9

TouchPad 12
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C
Cable Kit

contents 27

spare part number 22, 27, 35
cables, service considerations 43
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chipset, product description 2
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electrostatic discharge 44

equipment guidelines 47

esc key 10

Ethernet, product description 4

external media cards, product
description 5

external monitor port 14
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pointing device, product
description 6
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product description 6
USB 14,15

power button 9
power button board

removal 69

spare part number 22, 37, 69

power button board cable

disconnection 67
illustrated 27

power connector 15
power connector cable
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power cord
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product description 1
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spare part number 27, 37, 52
service tag 17, 48
serviceability, product description
7
Setup Utility (BIOS) 102
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tools required 43
top cover
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spare part numbers 22, 38,
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TouchPad button 12
TouchPad button board cable
disconnection 67
illustrated 27
TouchPad cable, illustrated 27
TouchPad components 12
TouchPad off light 12
TouchPad on light 12
TouchPad on/off button 12
TouchPad zone 12
transporting guidelines 46
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USB board
removal 75
spare part number 22, 37
USB board cable, illustrated 27
USB DVB-T TV tuner, spare part
number 32, 33
USB DVD-T antenna, spare part
number 32, 33
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video, product description 4



w
warranty period 18, 49
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